
Capture NX-D Reference Manual 1

En

Introduction Viewing Pictures Filters Image Adjustment Other Features Menu Guide

	 Capture NX-D Reference Manual
Introduction

What Capture NX-D Can Do for You.......................... 2
The Capture NX-D Window.......................................... 4
Palettes................................................................................ 5
The Toolbar........................................................................ 7
The Status Bar................................................................... 8
The Menu Bar.................................................................... 8

Viewing Pictures
Viewing Pictures.............................................................. 9
Side-by-Side Comparison...........................................12

Filters
Rating.................................................................................14
Labelling...........................................................................15
Filtering.............................................................................16

Image Adjustment
The Edit Palette..............................................................17
Exposure Compensation (RAW Images)................19
White Balance (RAW Images)....................................20
Picture Control (RAW Images)...................................21
Tone/Tone (Detail).........................................................22
Tool Buttons....................................................................23
Copying Adjustments..................................................28
File Format.......................................................................31

Other Features
Cropping Pictures..........................................................32
Batch Processing............................................................34
Printing Pictures.............................................................36
Printing Image Information.......................................37
Index Prints......................................................................38

Menu Guide
Menu Guide.....................................................................39

DD Visit the website below for tips and tricks and for updates to the beta version of Capture NX-D. We 
recommend that you visit this site frequently to ensure that you get the most from this product.
http://beta.nikonimglib.com

AA Save where otherwise stated, illustrations are from Windows 8.1. Default camera and software 
settings are assumed.

AA The links at the top of each page can be used for chapter navigation. Click  to return to this 
page.

http://beta.nikonimglib.com


Capture NX-D Reference Manual 2

Introduction Viewing Pictures Filters Image Adjustment Other Features Menu Guide

What Capture NX-D Can Do for You
Capture  NX-D lets you retouch pictures by, for example, adjusting brightness 
and hue, and can also be used to edit RAW images taken with Nikon digital cam-
eras and save them in other formats.

Retouch Pictures
With Capture NX-D, it’s easy to adjust such settings as brightness and white balance 
(page 17). Certain settings, such as exposure compensation and Picture Controls, 
are available only with RAW images.

Copy Adjustments
Save adjustments and apply them to other images (page 28) or copy them to other 
computers (page 30). Saved adjustments can be applied to multiple images using 
batch processing (page 34).

Save Pictures in Other Formats
Retouched or processed RAW (NEF/NRW) images can be saved in JPEG or TIFF 
formats for use in other applications (page 31).

.NEF .JPG .TIF
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What Capture NX-D Can Do for You

Retouching Pictures in Capture NX-D
Capture NX-D stores image adjustments in a separate “sidecar” file that is up-
dated automatically as settings are changed.

Image data

Picture Control settings

Exposure compensation

Settings file

Because changes to settings are stored separately from the original image data, 
the original picture can be restored at any time with no drop in quality.

Original image

Settings

Retouch preview

Retouch preview

Settings file deleted or 
settings reset

Original image

When files are converted to JPEG or TIFF, the changes are applied to the image as 
it is saved to create a new, modified image data file.

Settings 

Original image JPEG or TIFF file

A Image Adjustments
Image adjustments are stored in a “NKS_PARAM” folder in the same folder as the original image. All 
changes will be lost if this folder or the image adjustment file is deleted; similarly, because the image 
and the image adjustment file are linked via the file name, changes will be lost or applied to another 
image if the image adjustment file is renamed.
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The Capture NX-D Window
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q	Menu bar: Access the menus (page 8).

w	Toolbar: Choose a view and access image ad-
justment tools (page 7).

e	Folder palette: Select a folder to display its con-
tents in the image area (page 5).

r	Image area: View the images in the current 
folder.

t	Selected image: Selected images are highlight-
ed in gray. Double-click to preview (page 9).

y	Histogram palette: View the tone distribution 
for the selected image (page 5).

u	Edit/metadata palettes: Retouch images using 
the tools in the edit palette or switch to the 
metadata palette to view image information 
(page 6).

i	Status bar: View information on the selected 
image (page 8).

A The Navigation Palette
A navigation (bird’s eye) palette (page 5) appears when a preview is displayed by double-clicking a thumbnail in the image area.
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Palettes
Capture NX-D offers the following palettes.

The Folder Palette
The folder palette lists the folders in the com-
puter’s storage system. Click a folder to view the 
images it contains in the image area or preview 
display.

The folder palette menu gives access to recent 
folders. Frequently-used folders can be added to 
and then accessed from this menu.

Folder palette menu

The Histogram Palette
The histogram palette provides a constantly-up-
dated histogram for the selected thumbnail or 
the image in the preview display. The histogram 
shows the tone distribution for the color channel 
selected in the channel menu. Choose RGB to 
view overlapping distributions for the red, green, 
and blue channels: tone ranges in which the dis-
tributions for red and green overlap are shown in 
yellow, those in which red and blue overlap in ma-
genta, those in which green and blue overlap in 
cyan, and those in which all three colors overlap 
in white.

The Navigation (Bird’s Eye) Palette
The navigation palette is displayed above the 
folder palette when you double-click a thumbnail 
to display a preview.

When the preview is zoomed in, the frame in the 
navigation palette shows the area currently dis-
played. Drag the frame to view other areas of the 
preview.

Channel menu

A Palette Menus
To access the palette menu, click the triangle ( ) at the top right corner of the palette. Select Undock 
to open the palette in a floating window that can be moved freely about the display.



Capture NX-D Reference Manual 6

Introduction Viewing Pictures Filters Image Adjustment Other Features Menu Guide

Palettes

The Edit Palette
Use the tools in the edit palette to adjust the 
image currently selected or previewed in the 
image area. The tool list (page 17) offers Exposure 
Compensation, White Balance, Picture Control, 
and Tone/Tone (Detail) tools that can be accessed 
via pull-down menus or by clicking the tool icon 
and adjusting settings in the adjustments palette 
(page 17). Additional tools can be accessed using 
the tool buttons (page 18) at the bottom of the 
palette. The adjustment manager tool (page 18) can 
be used to copy adjustments to other images or 
save current settings for later use. To reset all tools 
and restore the image to the state it was in when 
first opened in Capture  NX-D, click the restore 
button (note that any changes made to JPEG and 
TIFF images in other applications since they were 
last opened in Capture NX-D will not be reset).

Tool listEdit tab

Adjustment manager

Tool buttons

Adjustments palette

Restore button

A The Edit and Metadata Palettes
Use the tabs at the top left corner to switch between the edit and metadata palettes.

The Metadata Palette
The metadata palette lists information on the im-
age currently selected or previewed in the image 
area, including exposure, the model of camera 
used to record the picture, and the date and time 
of recording. The metadata palette can be dis-
played in the position normally occupied by the 
folder palette (page 5)  by selecting Dock to Left 
in the palette menu.

Metadata tab
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The Toolbar
Use the toolbar to choose a view and access image adjustment tools.

q w ertyuio!0!1!2!3!4!5!6!7!8!9@0@1@2@3

q Print Print the image currently selected or previewed in the image area. Page 36

w Back/Foward Select the folder before or after the current folder. —

e Open Folder in Browser Display a dialog where you can navigate to and open a folder. Page 5

r Thumbnail View the images in the current folder as thumbnails. Page 9

t Combination
View a preview at the top of the image area with thumbnails listed 
underneath.

Page 10

y Preview Display the preview only. Page 9

u Full Screen View images full screen. Page 11

i Multi Preview
View images side-by-side. Choose from Compare Images and 
Compare Before and After Images.

Page 12

o Compare Images View selected images side-by-side. Page 12

!0
Compare Before and 
After Images

View an image as it appeared before adjustment side-by-side with 
the adjusted image.

Page 13

!1 Current
Apply current adjustments to the “before” image for use as a refer-
ence when making further modifications.

Page 13

!2 Original
Restore the “before” image to the state it was in before any adjust-
ments were made.

Page 13

!3 Preview Display Mode
Access the fit, combination, zoom, and hand tools or choose a 
zoom ratio for the image in the preview palette.

—

!4 Gray Point Sample Tool
Click a point in the preview to adjust white balance so that the 
sampled point takes on a neutral gray color.

Page 20

!5 Straighten Tool Straighten images. Page 26

!6 Crop Tool Crop images. Page 32

!7 Open with Open images in other applications. —

!8 Convert Files
Save images in JPEG or TIFF format. Adjustments are applied be-
fore the image is saved.

Page 31

!9 Batch Process Status View batch process status. Page 34

@0 Cancel Batch Process Cancel batch processing. —

@1 Rating/Label Filtering Filter images by rating or label. Page 16

@2 Filtering Filter images by rating, label, or camera settings. Page 16

@3 Cancel Filtering End filtering and view all images. —
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The Status Bar
View information on the image selected or previewed in the image area.

q w e r t y

q File name The file name.

w Zoom ratio The zoom ratio at which the preview is currently displayed.

e Color space The color space of the image in the preview display.

r Image size The size (in pixels) of the image in the preview display.

t Color value
The color of the pixel under the cursor in the preview and com-
bined displays.

y Position in folder
The position of the current image and the total number of images 
in the folder. Click  or  to view other images.

The Menu Bar
Access image adjustment tools or save images in other formats.

q w e r t y u i

q File Convert files to other formats, run batch processes, and print and rename files.

w Edit Select, copy, paste, and delete images.

e View Choose a view mode, adjust zoom, and sort and select images.

r Image Straighten, rate, and label images or display a grid or the focus point, shadows, or highlights.

t Adjust Copy, paste, save, and load image adjustment settings.

y Tool Access image adjustment tools.

u Window View and hide palettes.

i Help View online help or the current software version number.
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Viewing Pictures
Capture NX-D offers the following viewing options.

Thumbnails
At default settings, Capture NX-D lists the images in the current folder as thumb-
nails. Selected images are highlighted in gray.

Thumbnail list

Selected image

Previews
Double-click a thumbnail or select a thumbnail and click the  button in the 
toolbar to display a preview.

A Thumbnail Size
Use the slider above the image area to choose the thumbnail size.

Slider

A Returning to the Thumbnail View
To return to the thumbnail view, click the  button in the toolbar.

A Same Name, Different Extension
At default settings, if the folder contains two images 
with the same file names but different extensions (for 
example, RAW and JPEG images recorded at image 
quality settings of “RAW + JPEG”), only the RAW image 
will be displayed. To view all images, select Tool (or 
on the Mac, Capture NX-D) > Preferences > Show 
a NEF/NRW image as separate files.
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Viewing Pictures

Thumbnails and Previews Combined
To preview the current image with thumbnails above, below, or to one side, click 
the  button in the toolbar.

Preview palette

Thumbnail palette

Click thumbnails to preview other images.

A Choosing the Location of the Preview and Thumbnail Palettes
The locations of the preview and thumbnail palettes can be selected from the palette menus.

Preview palette menu

Thumbnail palette menu
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Viewing Pictures

Viewing Images Full Screen
To hide the menus, toolbar, and palettes and view the current image full screen, 
click the  button in the toolbar.

Use the left and right arrow keys on the keyboard to view additional images.

Full-screen display is also available in the multi-preview view (page 12).

Compare images Compare before and after images

To exit the full-screen display and return to the previous view, click the  button 
or press the Esc key.
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Side-by-Side Comparison
To compare multiple images side-by-side, or to compare before and after views 
of the same image, click the  button in the toolbar and choose  (Compare 
Images) or  (Compare Before and After Images).

Multi Preview button

Compare Images Compare Before and After Images

A Compare Images
On computers with at least 4 GB of memory and a 64-bit operat-
ing system, clicking the  button displays a menu that offers a 
four-image option in addition to the standard two-image com-
pare images option.

Compare Images (   )
Compare images side-by-side. When either image is zoomed or scrolled, the 
other will be zoomed or scrolled to match.

Current image

When you click the  button, the current image will be displayed on the left. To 
select images for display, click the desired preview box and then click a thumb-
nail. Only images in the same folder can be selected for side-by-side comparison.

Click

Click a 
thumbnail

The selected preview is highlighted in white. Image adjustments apply only to 
the selected preview, as do the histogram and navigation palette displays.

No adjustment Exposure compensation set to +1.0 EV

A Comparing Images in the Preview Display
Clicking the  button opens the images side-by-side 
in the preview display.
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Side-by-Side Comparison

Compare Before and After Images (   )
Compare before and after views of the current image.

Before After

n Updating the “Before” Image
To update the “before” image to reflect current image adjustments, click the  
button in the toolbar. The “before” image can then be used as a reference for 
subsequent changes to image adjustment settings.

n Restoring the “Before” Image
To restore the “before” image to its unadjusted state, click the  button in the 
toolbar. The “before” image will be restored to the state the image was in when 
first opened in Capture NX-D (note that any changes made to JPEG and TIFF im-
ages in other applications since they were last opened in Capture NX-D will not 
be reset).
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Rating
Pictures can be assigned ratings of from  (no rating) to five stars. Ratings are assigned using the thumbnail rating icons or the Apply Ratings op-

tion in the Image menu.

  1	 Select pictures.

AA To select multiple pictures, keep the Ctrl key 
(or on Mac computers, the /command key) 
pressed while clicking each image in turn. To se-
lect two pictures and all images between them, 
click the pictures while pressing Shift.

  2	 Click the  icon and choose a rating of from  (no rating) to five stars.

To assign the picture a three-star rating, 
click the third star from the left. The first 
three stars will be highlighted in yellow.

A “Apply Ratings”
Selected files can also be rated using the Apply Ratings option in the Image menu.
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Labelling
To make pictures easier to sort and locate, you can assign them labels of from “0” 
(no label) through “9”, each with its own unique color.

Ratings are assigned using the thumbnail label icons or the Apply Labels option 
in the Image menu.

  1	 Select pictures.

AA To select multiple pictures, keep the Ctrl key 
(or on Mac computers, the /command key) 
pressed while clicking each image in turn. To se-
lect two pictures and all images between them, 
click the pictures while pressing Shift.

  2	 Click a label (q; in the case of unlabelled images, the label “0” only appears 
when the cursor is over the picture) and choose a label of from “0” (no label) 
through “9” (w).

q	Click a label icon.

w	Click a label.

A “Apply Labels”
Selected files can also be rated using the Apply Labels option in the Image menu.
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Filtering
To filter pictures using criteria such as ratings, labels, and photo information, 
click the  button in the toolbar.

A dialog will be displayed where you can select 
filters. Only pictures that match at least one of the 
selected criteria will appear in the thumbnail list.

A Filters
The options for the Model, Focal Length, Shutter Speed, 
F Number, and ISO Sensitivity filters are restricted to values 
found in the images in the current folder.

Quick Filters
Use the  button in the toolbar to quickly filter pictures by rating and label.

  1	 Click the  button to display the filter bar.

Filter bar

  2	 Choose a filter or filters from the options in the filter bar.

AA If you select multiple ratings, all pictures with ratings in the selected range will be displayed. 
For example, selecting ratings of three and five stars displays pictures with ratings of three, 
four, and five stars.

Only pictures that match at least one of 
the selected criteria will appear in the 
thumbnail list.

A Viewing All Pictures
To cancel filtering and display all pictures in the current folder, click the  button in the toolbar.
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The Edit Palette
Most image adjustments are performed using the 
edit palette, which consists of a tool list, an adjust-
ments palette, and tool buttons.

The Tool List
The tool list contains the items listed below. All 
but Tone/Tone (Detail) apply exclusively to RAW 
(NEF/NRW) images.

Exposure Compensation Page 19

White Balance Page 20

Picture Control Page 21

Tone/Tone (Detail) Page 22

Settings for these tools can be selected from the 
pull-down menus. Selecting Recorded Value re-
stores settings to the values in effect when the 
image was first opened in Capture NX-D. At other 
settings, a check ( ) appears in the box to the 
right of the pull-down menu, and changes can be 
hidden by removing the check from the box ( ).

Tool list

Adjustment palette

The Adjustment Palette
Use the adjustment palette to make detailed adjustments. Clicking a tool button 
or an icon in the tool list displays settings for the selected item.

Tools that have been modified using the adjustment palette are identified by the 
label Manual in the tool list pull-down menus.
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The Edit Palette

Tool Buttons
The following tools can be accessed using the 
tool buttons at the bottom of the edit palette. 
Note that some of these tools can be used only 
with RAW (NEF/NRW) images; for information, see 
the section for each tool.

Noise Reduction Page 23

Lens Correction Page 23

LCH Page 24

Straighten Page 26

Unsharp Mask Page 26

Levels & Curves Page 27

These tools are accessed by clicking the buttons 
and adjusting settings in the adjustment palette. 
The buttons for tools that have been modified 
from default values are highlighted in yellow (e.g., 

).
Tool buttons

The Restore Button
Click the restore button to reset all tools and re-
store the image to the state it was in when first 
opened in Capture NX-D (note that any changes 
made to JPEG and TIFF images in other applica-
tions since they were last opened in Capture NX-D 
will not be reset).

Restore button

The Adjustment Manager Tool
Use the adjustment manager tool to copy adjust-
ments to other images or save current settings for 
later use (page 29).

Adjustment manager

A Retouching Multiple Images
Image adjustments apply simultane-
ously to all the images currently select-
ed in the thumbnail list.
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Exposure Compensation (RAW Images)
Adjust overall exposure, making images lighter or 
darker.

The pull-down menu in the tool list can be used to choose from values between 
+1.0 and –1.0 EV.

+1.0 EV

–1.0 EV

For values between +5.0 and –5.0 EV, incremented 
in steps of 0.01 EV, use the Exposure Compensation 
control in the image adjustment palette.

The image adjustment palette also offers an Active D-Lighting menu that can 
be used to bring out details in highlights and shadows.

Low Normal

High Extra high

A Active D-Lighting
Active D-Lighting is available only with RAW images taken using cameras that support Active 
D‑Lighting.
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White Balance (RAW Images)
Adjust white balance.

The pull-down menu in the tool list offers a choice of preset values.

Incandescent

Cloudy

White balance can be fine-tuned using the Color 
Temperature and Tint controls in the image ad-
justment palette. Tint can be set to values be-
tween –12 and +12: choose lower values for less 
green and more magenta, higher values for the 
opposite effect. The range of values available for 
Color Temperature vary with the option selected 
for white balance.

Gray point sample tool

White balance can also be set by sampling the image: click the  (Gray Point 
Sample Tool) button and click anywhere in the image to sample a single pixel, 
or drag the cursor over the image to use the average color value for the selected 
area. White balance for the entire image will be adjusted so that selected pixel 
or area takes on a neutral gray color.

Blue area sampled White balance adjusted to give blues a gray 
cast and the overall image a “warm” cast
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Picture Control (RAW Images)
Choose a Picture Control.

The pull-down menu in the tool list offers the fol-
lowing Picture Controls:
•	 Standard: Standard processing for balanced re-

sults.
•	 Neutral: Minimal processing for natural results. 

Choose for pictures that will later be extensively 
processed or retouched.

•	 Vivid: Pictures are enhanced for a vivid, photo-
print effect.

•	 Monochrome: Display the picture in monochrome.
•	 D2XMODE1/D2XMODE2/D2XMODE3: These custom Picture 

Controls produce results similar to the corresponding 
“Color Mode” settings for D2X and D2XS cameras. 

•	 Portrait: Process portraits for complexions with 
natural texture and a rounded feel.

•	 Landscape: Create vibrant landscapes and city
scapes.

Non-monochrome Monochrome

The controls in the image adjust-
ment palette can be used to fine-
tune individual Picture Control 
parameters, including sharpen-
ing, contrast, and saturation. What 
parameters are available depends 
on whether a monochrome Picture 
Control is selected.
•	 Sharpening: Control the sharpness 

of outlines. Choose higher values 
for more sharpening.

•	 Contrast: Adjust contrast. Choose 
lower values for less contrast, high-
er values for more contrast.

•	 Brightness: Adjust brightness without losing detail in highlights and shadows.
•	 Saturation (non-monochrome only): Control the vividness of colors. Choose lower val-

ues for less saturation, higher values for more saturation.
•	 Hue (non-monochrome only): Adjust hue.
•	 Filter Effect (monochrome only): Simulate the effects of color filters on monochrome 

photographs.
•	 Toning (monochrome only): Choose the tint used in monochrome photographs.
•	 Toning Saturation (monochrome only): Choose the saturation of the tint used in mono-

chrome pictures. Does not apply to black-and-white images.
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Tone/Tone (Detail)
Adjust overall brightness and contrast, or make adjustments that affect only 
highlights and shadows.

Tone
Clicking the icon shown at right displays the fol-
lowing controls in the image adjustment palette:
•	 Brightness: Adjust overall brightness. Choose 

from values between –100 and +100: the higher 
the value, the brighter the result.

•	 Contrast: Adjust overall contrast. Choose from 
values between –100 and +100: the higher the 
value, the greater the contrast.

•	 Saturation: Control the vividness of colors. Choose 
from values between –100 and +100: the higher 
the value, the more vivid (saturated) the result.

Tone (Detail)
Clicking the icon shown at right displays the fol-
lowing controls in the image adjustment palette:
•	 Highlight Protection: Preserve details in highlights. 

Values range from 0 to 100: choose higher val-
ues to reduce brightness in highlights.

•	 Shadow Protection: Preserve details in shadows. 
Values range from 0 to 100: choose higher val-
ues to increase brightness in shadows.

•	 D-Lighting HS: Brighten shadows in backlit or 
poorly-lit pictures or reduce loss of detail in 
highlights. Higher values reduce the contrast 
between shadows and highlights.
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Tool Buttons
Use the tool buttons for access to tools not in the tool list.

Noise Reduction
Selecting this tool displays the following controls 
in the image adjustment palette:
•	 Intensity: Choose from values between 0 and 100. 

Choosing a value greater than 0 activates noise 
reduction. The higher the value, the smooth-
er the image and the less visible the artifacts 
caused by image “noise”.

•	 Sharpness: Choosing high values for Intensity 
may smooth the image to the point that details 
are lost; this can be countered by increasing 
Sharpness.

•	 Method: Select Faster for faster processing, Better 
Quality for more accurate noise reduction.

•	 Color Moiré Reduction (RAW images only): Choose from 
settings of Off, Low, Medium, and High to re-
duce color moiré (an image artifact visible where 
regular patterns overlap).

•	 Astro Noise Reduction (RAW images only): Reduce the occurrence of randomly-spaced 
bright pixels in long exposures.

•	 Edge Noise Reduction (RAW images only): Make outlines more distinct by reducing the 
occurrence of noise artifacts around edges.

Lens Correction
Selecting this tool displays the following controls 
in the image adjustment palette:
•	 Lateral Color Aberration: Reduce lateral color aber-

ration (colored fringes and halos) in RAW imag-
es. At default settings, this option is not applied 
to JPEG and TIFF images.

•	 Axial Color Aberration: Reduce blurred colors 
caused by axial color aberration. Choose from 
values between 0 and 100: the higher the value, 
the greater the effect.

•	 Distortion Control: This option uses the lens infor-
mation recorded with photographs to reduce 
the barrel distortion associated with wide-angle 
lenses and the pin-cushion distortion associated with telephoto lenses.

•	 Vignette Control: Adjust for variations in peripheral illumination that occur with 
some lenses. Choose from values between –100 and +200: the higher the val-
ue, the greater the increase in brightness at the edges of the image.

•	 Fisheye: Process photos taken with AF DX Fisheye-Nikkor ED 10.5 mm f/2.8G or 
AF DX Fisheye-Nikkor ED 16 mm f/2.8D lenses so that they appear to have been 
taken with a wide-angle rectilinear lens.
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Tool Buttons

LCH
The LCH color space models color using values for 
lightness (a property similar but not identical to 
brightness or luminance), chroma (color satura-
tion), and hue. These parameters can be accessed 
via the channel menu in the image adjustment 
palette when the LCH tool is selected.

n Master Lightness
Adjust overall lightness without affecting 
chroma or hue.

q	Auto Contrast: Increase contrast by setting 
the white and black points to exclude a 
set proportion of the brightest and darkest 
pixels in the image.

w	Add Anchor Point: Click this button and then 
click the image in the preview palette to 
add a point to the curve corresponding to 
the lightness of the pixel under the cursor.

e	Reset Current Channel: Reset the master light-
ness curve to linear.

r	Reset All Channels: Reset the master lightness, 
color lightness, chroma, and hue curves to 
linear.

t	White-point output-level slider: Choose the 
maximum output level (white point).

y	Histogram: The histogram shows how the pixels in the image are distributed 
with respect to lightness. The horizontal axis corresponds to lightness (in the 
range 0–255), the vertical axis to the number of pixels.

qwer

t

y

u

i

o

!0

!1

u	Luminosity curve: The slope and shape of the curve determines the lightness of 
the image in the corresponding portion of the tone range.

i	Black-point output-level slider: Choose the minimum output level (black point).

o	Black-point input slider: Choose the minimum (black point) input level.

!0	Gamma: Choose the midpoint (gamma value).

!1	White-point input slider: Choose the maximum (white point) input level.

n Color Lightness
Adjust the lightness of selected colors without 
affecting chroma or hue. This can be used, for 
example, to brighten the blue of a dark skies.

q	Add Anchor Point: Click this button and then 
click the image in the preview palette to 
add a point to the curve corresponding to 
the value for the pixel under the cursor.

w	Reset Current Channel: Reset the color light-
ness curve to linear.

e	Reset All Channels: Reset the master lightness, 
color lightness, chroma, and hue curves to 
linear.

r	Color lightness curve: Moving a point on the 
curve upwards makes colors in the affected 
portion of the color range brighter, while 
moving it downward makes the affected 
colors darker.

t	Width slider: Adjust the width of the curve that passes through the selected 
point, increasing or decreasing the range of colors affected by the change.
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n Chroma
Increase or decrease color saturation over the 
entire image or a portion of the color range, 
making colors more or less vivid.

q	Add Anchor Point: Click this button and then 
click the image in the preview palette to 
add a point to the curve corresponding to 
the chroma of the pixel under the cursor.

w	Reset Current Channel: Reset the chroma curve 
to linear.

e	Reset All Channels: Reset the master lightness, 
color lightness, chroma, and hue curves to 
linear.

r	Chroma curve: Moving a point on the curve 
upwards makes colors in the affected por-
tion of the color range more vivid, while 
moving it downward makes the affected 
colors less vivid (grayer).

t	Output slider: Increase or decrease the saturation of all colors in the image.

y	Width slider: Adjust the width of the curve that passes through the selected 
point, increasing or decreasing the range of colors affected by the change.

u	Exclude Gray: Increasing chroma may make neutral colors (grays) seem over-
saturated. Select this option to increase chroma without affecting grays.
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n Hue
Map selected colors in the original (input) im-
age to a specific range of colors in the final 
(output) image. One application might be to 
deepen the colors in a pale blue sky.

q	Add Anchor Point: Click this button and then 
click the image in the preview palette to 
add a point to the curve corresponding to 
the hue of the pixel under the cursor.

w	Reset Current Channel: Reset the hue curve to 
linear.

e	Reset All Channels: Reset the master lightness, 
color lightness, chroma, and hue curves to 
linear.

r	Scale: Click to change the vertical scale from 
60 ° through 120 ° to 180 ° and back again 
(in this case the degrees refer to a 360 ° col-
or wheel). Increasing the scale increases 
the range of hues visible in the display, while decreasing the scale increases 
precision.

t	Hue curve: Select a point on the curve that corresponds to the desired input 
color and drag it up or down until it intersects with the desired output color.

y	Output slider: Modify the hue of all colors in the image.

u	Width slider: Adjust the width of the curve that passes through the selected 
point, increasing or decreasing the range of colors affected by the change.
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Straighten
Straighten pictures by up to ±10 °. Choose lower 
values to rotate the picture to the left, higher val-
ues to rotate it to the right.

Straighten tool

To straighten pictures manually, click the straighten tool in the image adjust-
ment palette and drag the cursor parallel to a line in the preview (this option can 
not be used with thumbnails; page 9). The image will be rotated by up to ±10 ° to 
make the reference line horizontal or vertical, and the degree of rotation will be 
displayed in the text box in the image adjustment window.

Drag cursor parallel to reference line Image rotated to make reference line horizontal

A Image Size
Straightening does not change the dimensions of the image. Any portions of the image that do not 
fit in its original dimensions are cropped out, while areas that have been added to the image are 
filled in black.

Unsharp Mask
Increase sharpness by making edges more 
distinct. The contrast of edges is increased 
while other areas are left untouched.

q	Delete: Delete the currently-selected mask 
from the unsharp mask list.

w	Move Up/Move Down buttons: Move the cur-
rently-selected mask up or down in the un-
sharp mask list.

e	Unsharp mask list: A list of unsharp masks, 
identified by color channel, intensity, halo 
width, and threshold (e.g., “Red, 50%, 10%, 
0”). Masks apply in the order listed; to 
change the order, use the up/down but-
tons.

r	Color: Choose the color channel to which 
the unsharp mask applies.

t	Intensity: The amount edge contrast will be 
increased.

y	Radius: The greater the radius, the wider the 
edges in the sharpened image will appear.

u	Threshold: The limit at which sharpening will 
be applied. If the threshold is zero, sharpening will apply to all pixels in the 
image. Increasing the threshold increases the amount of contrast that must 
be present between pixels before the mask will be applied, with the result 
that only more distinctly contrasting edges will be affected.
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Levels & Curves
Adjust contrast, tone (brightness), and color 
balance. Adjustments can be made over the 
entire image or to specific portions of the tone range (for example, the gamut of 
a specific printer, monitor, or other output device), allowing enhancements to be 
made without sacrificing detail.

q	Channel: The current color channel.

w	Auto Contrast: Increase contrast by setting 
the white and black points to exclude a 
set proportion of the brightest and dark-
est pixels in the image, creating a curve 
that makes optimal use of the output tone 
range while preserving details in shadows 
and highlights.

e	Black Point: Click this button and then click 
the image in the preview palette to set the 
black point for the red, green, and blue 
channels to the value for the pixel under 
the cursor.

r	Midpoint: Click this button and then click 
the image in the preview palette to set the 
midpoint for the red, green, and blue chan-
nels to the value for the pixel under the 
cursor.

t	White Point: Click this button and then click the image in the preview palette to 
set the white point for the red, green, and blue channels to the value for the 
pixel under the cursor.

y	Add Anchor Point: Click this button and then click the image in the preview area 
to add a point to the curve corresponding to the value of the pixel under the 
cursor.

u	Reset Current Channel: Reset the curve for the current channel to linear.

werto

!0

!1

!2
!3

!5
!4

iyu

q

i	Reset All Channels: Reset all curves to linear.

o	White-point output-level slider: Choose the maximum output level (white point). 
Dragging the slider down lowers the brightness of the brightest pixels.

!0	Histogram: The histogram shows how the pixels in the image are distributed 
with respect to brightness. The horizontal axis corresponds to brightness (in 
the range 0–255), the vertical axis to the number of pixels.

!1	Tone curve: The slope and shape of the curve determines the brightness of the 
image in the corresponding portion of the tone range.

!2	Black-point output-level slider: Choose the minimum output level (black point). 
Dragging the slider up increases the brightness of the darkest pixels.

!3	Black-point input slider: Any pixels in the portion of the tone range to the left of 
the black point are output at the minimum output level. Dragging the slider 
to the right steepens the curve and enhances contrast but may cause loss of 
details in shadows.

!4	Gamma: Dragging the slider to the left increases the brightness of mid-tones, 
while dragging it to the right makes mid-tones darker.

!5	White-point input slider: Any pixels in the portion of the tone range to the right 
of the white point are output at the maximum output level. Dragging the 
slider to the left steepens the curve and enhances contrast but may cause 
loss of details in highlights.

A Sampling the Current Channel
By default, the black point, midpoint, white point, add anchor point, and auto contrast controls re-
spectively set the black point, anchor points, white point, and contrast for all channels. To apply 
these controls only to the current channel, press Ctrl (or on Mac computers, the option key) while 
clicking the control.
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Copying Adjustments
Image adjustments can be copied and applied to other pictures, speeding the 
process of enhancing pictures taken under similar conditions.

Adding Adjustments to the Tool List
Current settings can be added to the menus in the tool list.

  1	 Select a tool from the tool list and adjust set-
tings in the adjustment palette. Here we have 
set exposure compensation (page 19) to +1.50.

  2	 Select Register Adjustments from the pull-
down menu in the tool list.

  3	 Enter a name for the new setting and click 
OK. In this example, we have named the set-
ting +1.5.

The new setting is added to the pull-down 
menu and can now be applied to other pic-
tures.

AA Selecting Edit Registered Adjustments from the 
pull-down menu displays a dialog where you can re-
name or delete previously-saved settings.
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The Adjustment Manager Tool
The adjustment manager can be used to apply multiple adjustments simultane-
ously.
•	 Copy Updated Adjustments: Copy all adjustments 

that have been changed since the current folder 
was selected.

•	 Copy All Adjustments: Copy all adjustments.
•	 Paste Adjustments: Apply adjustments copied us-

ing Copy Updated Adjustments or Copy All 
Adjustments to the currently-selected image or 
images.

•	 Save Updated Adjustments: Save all adjustments 
that have been changed since the current folder 
was selected.

•	 Save All Adjustments: Save all adjustments.
•	 Load Adjustments: Select an adjustments file saved 

using Save Updated Adjustments or Save All 
Adjustments and apply it to the currently-se-
lected image or images.

•	 Register Updated Adjustments: Any adjustments that 
have been changed since the current folder was 
selected are saved and added as an option to 
the adjustment manager pull-down menu.

•	 Register All Adjustments: All current adjustments 
are saved and added as an option to the adjust-
ment manager pull-down menu.

•	 Edit Registered Adjustments: Reorder, rename, or delete adjustments previously 
added to the adjustment manager pull-down menu.

n Copying Adjustments to Other Pictures
Follow the steps below to copy adjustments and apply them to other images.

  1	 Adjust settings in the edit palette. Here we have set exposure compensation 
(page 19) to –1/2 EV and selected the Vivid Picture Control (page 21).

  2	 Click the adjustment manager  icon and se-
lect Copy Updated Adjustments or Copy All 
Adjustments from the options in the adjust-
ment palette. Here we have selected Copy 
All Adjustments.

  3	 Select images. In this example, the selected image has already been ad-
justed using the exposure compensation (page 19) and white balance (page 20) 
tools.
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  4	 Click the adjustment manager  icon and se-
lect Paste Adjustments from the options in 
the adjustment palette.

The adjustments copied in Step 2 are applied to the images selected in 
Step 3. Because we selected Copy All Adjustments in Step 2, exposure com-
pensation changes to –1/2 EV while white balance reverts to Original.

AA Had we selected Copy Updated Adjustments in Step 2, the exposure compensation and 
Picture Control for the selected image would have been set to the values selected in Step 1, 
while white balance would have remained at the value selected in Step 3.

n Copying Adjustments to Other Computers
The Save Updated Adjustments and Save All 
Adjustments options save image adjustments 
to a file which can be copied to other computers. 
The adjustments can then be applied to selected 
pictures on the other computers using Load Saved 
Adjustments.

n Adding Adjustments to the Adjustment Manager
Use the Register Updated Adjustments and Register All Adjustments options 
to add adjustments to the adjustment manager pull-down menu.

A Copying Adjustments from RAW to JPEG or TIFF Images
When adjustments are copied from RAW (NEF/NRW) to JPEG or TIFF images, exposure compensa-
tion, Picture Controls, and other settings that are available only with RAW images will not be applied.
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File Format
To save RAW (NEF/NRW) images in JPEG or TIFF format, click the  button in the 
toolbar.

A dialog will be displayed where you can choose a file format and adjust such 
settings as compression and image size.
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q	Save as type: Choose JPEG or TIFF.

w	File format (TIFF only): Choose the bit depth for TIFF images (8 or 16 bits per chan-
nel).

e	Quality (JPEG only): Use the slider to choose a value between 1 and 5. The lower 
the value, the lower the compression ratio and the higher the image quality; 
the higher the value, the higher the compression ratio and the smaller the file 
size.

r	Use LZW compression(TIFF only): Compress TIFF files using “lossless” LZW compres-
sion.

DD LZW compression may sometimes increase file size when applied to 16-bit images.

t	Resolution: Select this option to choose the output resolution.

y	Embed ICC profile: Select this option to embed the current color profile in the 
image.

u	Specify size: Select this option to resize pictures saved in the new format. The 
new size can be entered in pixels, centimeters, or inches. When you enter a 
value for either Long edge or Short edge, the remaining value will automati-
cally be adjusted to maintain the original aspect ratio.



Capture NX-D Reference Manual 32

Introduction Viewing Pictures Filters Image Adjustment Other Features Menu Guide

Cropping Pictures
To crop unwanted areas from images, click the  button in the toolbar.

The crop palette will be displayed. Follow the steps below to crop images.

  1	 Choose an aspect ratio in the crop palette and click Apply Ratio. A crop with 
the selected aspect ratio will appear over the preview image.

AA The aspect ratio can be changed after you have resized and positioned the crop.

  2	 Drag the corners of the crop to resize it without changing the aspect ratio. If 
you selected Free Crop in Step 1, you can also drag the edges of the crop.

To position the crop, drag the  icon in the center. The crop can be rotated 
90 ° by clicking the  icon.

AA The crop can only be rotated in increments of 90 °.
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  3	 Click the  button in the toolbar to crop the image. A Crop
Crops are not applied to the original image data. The crop can be changed at any time by clicking 
the  button in the toolbar.

Crops are applied when images are converted to JPEG or TIFF (page 31).
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Batch Processing
The File > Run Batch Process option can be used to perform the same image 
adjustments on all pictures in a selected folder and then export the processed 
images in a selected file format. Batch processing options are shown below.
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q	Source folder: Click Browse to choose a source folder. To include all images in 
sub-folders under the selected folder, select Include sub-folders.

w	Adjustments: Select Apply current adjustments to process the images using 
the adjustments for the current image. To apply adjustments previously 
saved from the adjustment manager, choose Adjustments to apply and click 
Change adjustments to choose an adjustments file. To export the images in 
the selected folder in another format without changing the settings currently 
selected for each image, choose Apply adjustments already in files.

e	File format: Select the format in which the processed files will be saved. Choose 
from JPEG, TIFF 8 bit, and TIFF 16 bit.

r	Quality (JPEG only): Use the slider to choose a value between 1 and 5. The lower 
the value, the lower the compression ratio and the higher the image quality; 
the higher the value, the higher the compression ratio and the smaller the file 
size.

t	Use LZW compression(TIFF only): Compress TIFF files using “lossless” LZW compres-
sion.

DD LZW compression may sometimes increase file size when applied to 16-bit images.

y	Resolution: Select this option to choose the output resolution.

u	Embed ICC profile: Select this option to embed the current color profile in each 
image.

i	Specify size: Select this option to resize pictures saved in the new format. The 
new size can be entered in pixels, centimeters, or inches. When you enter a 
value for either Long edge or Short edge, the remaining value will automati-
cally be adjusted to maintain the original aspect ratio.

o	Destination: Select Use source folder to save the processed files to the current 
folder. To choose a different folder, remove the check from this option and 
click Browse. To save the processed files under the same names as the origi-
nals, select Use source file name (if a file with the same name and extension 
already exists in the current folder, the processed file will be renamed by add-
ing a number to the file name); to choose different names, remove the check 
from this option and click Edit.



Capture NX-D Reference Manual 35

Introduction Viewing Pictures Filters Image Adjustment Other Features Menu Guide
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Clicking Start starts processing and displays a progress dialog. Progress can be 
viewed in the Queued and Finished tabs.
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Queued Finished

q	Source: A list of the files that are awaiting processing or have been processed.

w	Automatically Show/Hide: Removing the check from this option hides the prog-
ress dialog. The progress dialog can be displayed by clicking the  button in 
the toolbar.

e	Delete: Click to remove the file selected in the Queued tab from the queue, or 
to delete the log for the file selected in the Finished tab.

r	View folder: Open the destination folder in the operating system file browser.

A File Conversion
If multiple files are selected when the  button in 
the toolbar is used to export files in another format 
(page 31), the files will be exported as a batch process. 
Adjust settings as described for items e through o 
on page 34.
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Printing Pictures
To print pictures on a printer connected to the computer, select the pictures and 
click the  button in the toolbar. The “Print” dialog will be displayed.

Adjust settings as described on the following page and click Print to print the 
picture as shown in the preview.

The “Print” Dialog

Print Type

•	 Full Page: Print one picture per page.
•	 Index Print: Print multiple images per page (page 38).
•	 Standard Photo Sizes: Print pictures at a standard photo size. Capture NX-D automatically 

chooses the number of pictures printed on each page.

Printer Setup

Printer Click Settings to choose the printer and paper size and adjust other printer settings.

Printer Type Choose Inkjet when printing on an inkjet printer.

Print Priority
When printing NEF/NRW (RAW) pictures, choose Speed to use the preview data embed-
ded in the image for faster printing, or Quality to use the original image data for higher 
quality output.

Copies Choose the number of copies of each page printed.

Page Layout

Rotate to fit Rotate pictures to print them at the largest possible size.

Crop images 
to fit

Pictures are enlarged to fill the print area. Portions that do not fit in the print area are 
cropped out.

Background 
Color

Choose the background color. Choose White to print with no background.

Border width
Choose the width of the borders printed around the image (the color of the borders varies 
with the background color). Choose 0 to print without borders.

Copies of 
each image

Choose the number of copies of each photo printed.

Print 
 Information

Print the file name, date of recording, or photo information under each picture (page 37).

A Notes on Printing
Pictures can not be printed from the full-screen display.

To print to a JPEG file, click File Output.

The most recently-used settings are recalled when the print dialog is next displayed.
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Printing Image Information
To choose the information printed under each picture, select Print Information 
in the “Print” dialog (page 36), click Settings, and adjust the settings described on 
the following page.

Advanced Print Information Settings

Date/Tim
e Shot

Date Shot Print the date of recording in the position selected for Position.

Time Shot Print the time of recording together with the date.

Font Settings
Choose the font, style, font point size, and color used to print the date/time stamp. The 
results can be previewed in the “Sample” area.

Metadata
Choose the file and photo information printed with each picture. The font, style, and font 
point size can be selected in the “Font Settings” area and previewed in the “Sample” area.

Header/Footer

Header
Enter the text and choose the alignment for the header that will be printed at the top of 
each page.

Page 
Number

Choose whether to print the page number and the total number of pages and select the 
position and alignment. The page number can be positioned at the page Top (in the 
header) or Bottom (in the footer).

Footer
Enter the text and choose the alignment for the footer that will be printed at the bottom 
of each page.

Font Settings
Choose a font, style, and font point size for the header, footer, and page number. The re-
sults can be previewed in the “Sample” area.

D Print Information
Print information is not rotated when Rotate to fit is selected in the “Print” dialog. Metadata that 
does not fit in the print area will be omitted.
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Index Prints
To print multiple images per page, select Index Print for “Print As” in the “Print” 
dialog (page 36) and choose the number of pictures printed per page.

Standard
Choose the number of pictures per page from 
a list box. The size of the pictures is automati-
cally adjusted according to the option selected.

A 2 × 4 layout

 Image Size
Pictures are printed at the size entered for 
“Width” and “Height” (the minimum size is 
20.0  mm  × 20.0  mm and the maximum the 
same as the page size). The number of pictures 
per page is automatically adjusted according 
to the size selected.

Pictures printed at 50 mm × 50 mm

Column and Row
Choose the number of columns and rows 
printed per page (the minimum is 1 and the 
maximum 10). The size of the pictures is au-
tomatically adjusted according to the options 
selected.

A 3 × 3 layout
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The Capture NX-D Menu (Mac Only)
•	 Preferences: Open the Capture NX-D preferences 

dialog.
•	 Quit Capture NX-D: Quit Capture NX-D.

The File Menu
•	 New Folder: Create a new sub-folder in the current 

folder.
•	 Rename Folder: Rename the current folder.
•	 Open in Explorer (Windows)/Open in Finder (Mac OS): 

Open the current folder in the operating system 
file browser.

•	 Convert Files: Convert the currently-selected im-
age or images to JPEG or TIFF format (page 31).

•	 Run Batch Process: Perform batch processing (page 
34).

•	 Rename: Rename the current image.
•	 Page Setup: Adjust printer settings.
•	 Print: Print images (page 36).
•	 Exit (Windows only): Exit Capture NX-D.

The Edit Menu
•	 Undo: Undo the most recent operation.
•	 Redo: Redo an operation after performing Undo.
•	 Cut/Copy/Paste: Cut, copy, or paste the current se-

lection.
•	 Delete: Delete the current selection.
•	 Select All: Select all images in the current folder.
•	 Invert Selection: Select all images in the current 

folder that are not currently selected and dese-
lect any images that are currently selected.

•	 Deselect All: Deselect all images.
•	 Select File: Select all files in the current folder that 

match the criteria chosen in the Select File submenu.

The View Menu
•	 Go: Navigate the folder hierarchy.
•	 View Mode: Choose how images are displayed 

(page 9).
•	 Thumbnail Size: Choose the thumbnail size 

(page 9).
•	 Sort Thumbnails by: Sort thumbnails.
•	 Filter: Filter images according to selected cri-

teria (page 16).
•	 Zoom In/Zoom Out/View at/Fit to Pane: Zoom the 

preview in or out.
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The Image Menu
•	 Next Image/Previous Image: View the next or 

previous image in the current folder.
•	 Open With: Open the current image in anoth-

er application. Use the Register option to 
add applications to the menu.

•	 Rotate: Rotate the current image 90 or 180 
degrees.

•	 Show Grid: Display a grid over the preview.

•	 Show Focus Point: Show the focus point in the 
preview display.

•	 Show Lost Highlights: View areas of the image 
with the maximum value for brightness and in 
which details may have been lost to overexpo-
sure (“washed out”). A different color is used 
to show the lost highlights for each of the RGB, 
red, green, and blue channels.

•	 Show Lost Shadows: View areas of the image 
with the minimum value for brightness and in 
which details may have been lost to underex-
posure. A different color is used to show the 
lost shadows for each of the RGB, red, green, 
and blue channels.

•	 Apply: Label (page 15) or rate (page 14) selected images.

The Adjust Menu
•	 Restore: Reset all image adjustments.
•	 Copy Updated Adjustments: Copy only 

those adjustments that have been 
changed since the current folder was 
last opened.

•	 Copy All Adjustments: Copy all adjustments.
•	 Paste Adjustments: Apply to the cur-

rent image adjustments copied using 
Copy Updated Adjustments or Copy 
All Adjustments.

•	 Save Updated Adjustments: Create a file containing only those adjustments that 
have been changed since the current folder was last opened.

•	 Save All Adjustments: Save all adjustments to a file.
•	 Load Adjustments: Load adjustments from a file created with Save Updated 

Adjustments or Save All Adjustments and apply them to the current image.
•	 Cancel Crop Area: Cancel the current crop (page 32).
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The Tool Menu
•	 Fit: Double-click the display to alternately 

zoom the preview to fit the palette and 
zoom to a 100% view.

•	 Combination Tool: As above, except that the 
preview can be scrolled by dragging the 
cursor.

•	 Zoom Tool: Click to zoom in. To zoom out, 
click while pressing the Alt key (or on Mac 
computers, the option key).

•	 Hand Tool: Drag to scroll the preview.
•	 Gray Point Sample Tool: Set white balance by 

sampling the preview (page 20).
•	 Crop Tool: Crop the preview (page 32).
•	 Straighten Tool: Straighten the image in the preview palette (page 26).
•	 Launch Picture Control Utility: Launch the Picture Control Utility.
•	 Synchronize Edits: Select this option to apply current settings to any images sub-

sequently added to the current folder.
•	 Preferences (Windows only): Open the Capture NX-D preferences dialog.

The Window Menu
•	 Histogram/Edit/Metadata/Bird’s Eye/Folders: View or hide 

the selected palette.
•	 Show Tool Bar: View or hide the toolbar.
•	 Show Status Bar: View or hide the status bar.
•	 Show Palettes: View or hide all palettes.

The Help Menu
•	 Capture NX-D Help: View online help.
•	 About Capture  NX-D: Display the product version 

number.


